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1 Introduction to Polyspace® Products for Verifying C/C++ Code

Product Overview

In this section...

“Polyspace Products for C/C++” on page 1-2
“Overview of Polyspace Verification” on page 1-2

“The Value of Polyspace Verification” on page 1-3

Polyspace Products for C/C++

Polyspace Client for C/C++

Polyspace® Client™ for C/C++ provides code verification that proves the
absence of overflow, divide-by-zero, out-of-bounds array access, and certain
other run-time errors in source code using static code analysis that does not
require program execution, code instrumentation, or test cases. Polyspace
Client for C/C++ uses formal methods-based abstract interpretation
techniques to verify code. You can use it on handwritten code, generated code,
or a combination of the two, before compilation and test.

Polyspace Server for C/C++

Polyspace® Server™ for C/C++ provides code verification that proves the
absence of overflow, divide-by-zero, out-of-bounds array access, and certain
other run-time errors in source code. For faster performance, Polyspace Server
for C/C++ lets you schedule verification tasks to run on a computer cluster.
Jobs are submitted to the server using Polyspace Client for C/C++. You can
integrate jobs into automated build processes and set up e-mail notifications.
You can view defects, regressions, and code metrics via a Web browser. You
then use the client to download and visualize verification results.

Overview of Polyspace Verification

Polyspace® products verify C, C++, and Ada code by detecting run-time errors
before code is compiled and executed.

To verify the source code, you set up verification parameters in a project, run

the verification, and review the results. A graphical user interface helps you
to efficiently review verification results. Results are color-coded:
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Product Overview

® Green — Indicates code that never has an error.

Red - Indicates code that always has an error.

Gray — Indicates unreachable code.
® Orange — Indicates unproven code (code that might have an error).
The color-coding helps you to quickly identify errors and find the exact

location of an error in the source code. After you fix errors, you can easily run
the verification again.

The Value of Polyspace Verification
Polyspace verification can help you to:

e “Ensure Software Reliability” on page 1-3
® “Decrease Development Time” on page 1-4

¢ “Improve the Development Process” on page 1-4

Ensure Software Reliability

Polyspace software ensures the reliability of your C and C++ applications by
proving code correctness and identifying run-time errors. Using advanced
verification techniques, Polyspace software performs an exhaustive
verification of your source code.

Because Polyspace software verifies all possible executions of your code, it
can identify code that:

® Never has an error

® Always has an error

® [s unreachable

Might have an error

With this information, you know how much of your code is free of run-time
errors, and you can improve the reliability of your code by fixing errors.
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You can also improve the quality of your code by using Polyspace verification
software to check that your code complies with established coding standards,
such as the MISRA C®, MISRA® C++ or JSF++ standards.’

Decrease Development Time

Polyspace software reduces development time by automating the verification
process and helping you to efficiently review verification results. You can use
it at any point in the development process. However, using it during early
coding phases allows you to find errors when it is less costly to fix them.

You use Polyspace software to verify source code before compile time. To
verify the source code, you set up verification parameters in a project, run
the verification, and review the results. This process takes significantly less
time than using manual methods or using tools that require you to modify
code or run test cases.

Color-coding of results helps you to quickly identify errors. You will spend
less time debugging because you can see the exact location of an error in the
source code. After you fix errors, you can easily run the verification again.

Using Polyspace verification software helps you to use your time effectively.
Because you know which parts of your code are error-free, you can focus on
the code that has definite errors or might have errors.

Reviewing code that might have errors (orange code) can be time-consuming,

but Polyspace software helps you with the review process. You can use filters
to focus on certain types of errors or you can allow the software to identify the
code that you should review.

Improve the Development Process

Polyspace software makes it easy to share verification parameters and
results, allowing the development team to work together to improve product
reliability. Once verification parameters have been set up, developers can
reuse them for other files in the same application.

1. MISRA and MISRA C are registered trademarks of MISRA Ltd., held on behalf of the
MISRA Consortium.



Product Overview

Polyspace verification software supports code verification throughout the
development process:

¢ An individual developer can find and fix run-time errors during the initial
coding phase.

® Quality assurance engineers can check overall reliability of an application.

® Managers can monitor application reliability by generating reports from
the verification results.
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Product Components

In this section...

“Polyspace Verification Environment” on page 1-6

“Other Polyspace Components” on page 1-10

Polyspace Verification Environment

The Polyspace verification environment (PVE) is the graphical user interface
of the Polyspace Client for C/C++ software. You use the Polyspace verification
environment to create Polyspace projects, launch verifications, and review
verification results.

The Polyspace verification environment consists of three perspectives:

® “Project Manager Perspective” on page 1-6
¢ “Coding Rules Perspective” on page 1-8

¢ “Run-Time Checks Perspective” on page 1-9

Project Manager Perspective

The Project Manager perspective allows you to create projects, set verification
parameters, and launch verifications.
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You use the Project Manager perspective in the tutorial in Chapter 2, “Setting

Up a Polyspace Project”.



1 Introduction to Polyspace® Products for Verifying C/C++ Code

Coding Rules Perspective
The Coding Rules perspective allows you to review results from the Polyspace
coding rules checker, to ensure compliance with established coding standards.

File Edit Run Review Options Window Help

EECIEREEECELREID | o)~

® Assistant Coding Rules @ 23 | # MISRAC
¥+ 1+ Filter l:l Hide justified violated rules i
. >
Rulle File Line  Col | wfe Rule File Line Col Classification Status Justified  Comment
i warning |17.4  |example.c a7 7
warning (17,4 |example.c 114 21
warning |17.4  |example.c 118 14

“" Rule details

Bule: 16.3 (error): Identifiers shall be given for all of the parameters in a function prototype declaration.
File: C:\Poly3pace‘\polyspace_projectiincludesi\include.h line 33 (column 28&)

Source code
|extern void Exec One_ Cvcle (int):

b 0% l| Ready

You use the Coding Rules perspective in the tutorial in Chapter 5, “Checking
Compliance with Coding Rules”.
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Run-Time Checks Perspective

The Run-Time Checks perspective allows you to review verification results,
comment individual checks, and track review progress.
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You use the Run-Time Checks perspective in the tutorial in Chapter 4,
“Reviewing Verification Results”.
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Other Polyspace Components

In addition to the Polyspace verification environment, Polyspace products
provide several other components to manage verifications, improve
productivity, and track software quality. These components include:

¢ Polyspace Queue Manager Interface (Spooler)

e Polyspace in One Click
¢ Polyspace Metrics Web Interface

Polyspace Queue Manager Interface (Polyspace Spooler)

The Polyspace Queue Manager (also called the Polyspace Spooler) is the
graphical user interface of the Polyspace Server for C/C++ software. You
use the Polyspace Queue Manager Interface to move jobs within the queue,
remove jobs, monitor the progress of individual verifications, and download

results.
Polyspace Queue Manager Interface EI@
Operaticns Help
D Author Application Results folder CPU Status Date Language

----- 23 |username |example_project |C:\PolySpace'polyspace_project\verification_1\Result 9 |AH-SRUNS... |completed |15-Dec-2010, 16:03:33 |C
4 a a o 0 a 0 a o catio 0 A g 0 010 6.0

25 |username  |example_project |C:\PolySpace\polyspace_project\Werification_1'Result 11 queued 15-Dec-2010, 16:03:21 |C

Connected to Queue Manager AH-SRUNSTRO.dhcp.mathworks.com User mode

You use the Polyspace Queue Manager in the tutorial “Launching Server
Verification from Project Manager” on page 3-11.

Polyspace in One Click

Polyspace in One Click is a convenient way to verify multiple files using the
same set of options.



Product Components

After creating a project with the options that you want, you can use Polyspace
in One Click to designate that project as the active project, and then send
source files to Polyspace software for verification with a single mouse click.

You use Polyspace in One Click in the tutorial “Using Polyspace In One Click
to Launch Verification” on page 3-23.

Polyspace Metrics Web Interface

Polyspace Metrics is a web-based tool for software development managers,
quality assurance engineers, and software developers. Polyspace Metrics
allows you to evaluate software quality metrics, and monitor changes in code
metrics, coding rule violations, and run-time checks through the lifecycle

of a project.

For information on using Polyspace Metrics, see “Software Quality with
Polyspace Metrics”in the Polyspace Products for C/C++ User’s Guide.
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Installing Polyspace Products

In this section...

“Finding the Installation Instructions” on page 1-12

“Obtaining Licenses for Polyspace® Client for C/C++ and Polyspace® Server
for C/C++” on page 1-12

Finding the Installation Instructions

The tutorials in this guide require Polyspace Client for C/C++ and Polyspace
Server for C/C++. Instructions for installing Polyspace products are in the
Polyspace Installation Guide. Before installing Polyspace products, you must
obtain the necessary licenses.

Obtaining Licenses for Polyspace Client for C/C++
and Polyspace Server for C/C++

For information about obtaining licenses for Polyspace products, see
“Polyspace License Installation” in the Polyspace Installation Guide.



Working with Polyspace® Software

Working with Polyspace Software

In this section...

“Basic Workflow” on page 1-13

“Tutorials in This Guide” on page 1-14

Basic Workflow

The following graphic shows the basic workflow for using Polyspace software
to verify source code.

Set up project

A4

Verify code

A 4

3
Review verification results

In this workflow, you:

1 Use the Project Manager perspective to set up a project file.

2 Verify code on a server or client.

You can use the Project Manager perspective to start the verification or
you can select files from a Microsoft® Windows® folder and send them to
Polyspace software for verification. For verifications that run on a server,
you use the Polyspace Queue Manager Interface (Polyspace Spooler) to
manage the verification and download the results to a client. You can set an
option to check coding rules compliance in the first stage of the verification.
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3 Use the Run-Time Checks perspective to review verification results.

Tutorials in This Guide
The tutorials guide you through the basic workflow, including the different
options for running verifications. The following graphic shows the workflow

you follow in these tutorials.

Create new project

Review verification results

A 4

4
Check MISRA C compliance

In this workflow, you:
1 Create a new project that you use for the workflow.

This step is in the tutorial in Chapter 2, “Setting Up a Polyspace Project”.

2 Verify a single C file.
This step is in the tutorial in Chapter 3, “Running a Verification”. In this
tutorial, you verify the same file using three different methods of running a
verification:
e Start a verification that runs on a server using the Project Manager

perspective.



Working with Polyspace® Software

® Send files to a server for verification using Polyspace In One Click.

e Start a verification that runs on a client using the Project Manager
perspective.

3 Review the verification results.
This step is in the tutorial in Chapter 4, “Reviewing Verification Results”.

4 Modify the project to include MISRA C checking and review the MISRA C
violations in the example file.

This step is in the tutorial in Chapter 5, “Checking Compliance with
Coding Rules”.
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Additional Information and Support

In this section...

“Product Help” on page 1-16
“MathWorks Online” on page 1-16

Product Help

To access Polyspace online Help, select Help > Help .

To access the online documentation for Polyspace products, go to:
www.mathworks.com/help/toolbox/polyspace/polyspace_product_page.html
MathWorks Online

For additional information and support, go to:

www.mathworks.com/products/polyspace
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Related Products

Related Products

In this section...

“Polyspace Products for Verifying Ada Code” on page 1-17

“Polyspace Products for Linking to Models” on page 1-17

Polyspace Products for Verifying Ada Code

For information about Polyspace products that verify Ada code, go to:
http://www.mathworks.com/products/polyspaceclientada/
http://www.mathworks.com/products/polyspaceserverada/
Polyspace Products for Linking to Models

For information about Polyspace products that link to models, go to:
http://www.mathworks.com/products/polyspacemodelsl/

http://www.mathworks.com/products/polyspaceumlrh/

1-17
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Setting Up a Polyspace
Project

e “About Setting Up a Project Tutorial” on page 2-2

e “Creating a New Project” on page 2-3



2 Setting Up a Polyspace Project

About Setting Up a Project Tutorial

In this section...

“Overview” on page 2-2

“Example Files” on page 2-2

Overview

You must have a project before you can run a Polyspace verification of your
source code. In this tutorial, you create the project that you use to run
verifications in later tutorials.

Example Files

This tutorial uses the source file example.c that comes with the installation.
You learn more about the files and folders required for this tutorial in
“Preparing Project Folders” on page 2-4.



Creating a New Project

Creating a New Project

In this section...

“What Is a Project?” on page 2-3
“Preparing Project Folders” on page 2-4
“Opening Polyspace Verification Environment” on page 2-5

“Creating a New Project to Verify the Example C File” on page 2-7

What Is a Project?

In Polyspace software, a project is a named set of parameters for verification
of your software project’s source files. A project includes:

e Source files

Include folders

® One or more Configurations, specifying a set of analysis options

® One or more Modules, each of which include:
= Source (specific versions of source files used in the verification)
= Configuration (specific set of analysis options used for the verification)
= Verification results

You can create your own project or use an existing project. You create and
modify a project using the Project Manager perspective.

In this tutorial, you create a new project and save it as a configuration file
(.cfg).
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Preparing Project Folders

Before you start verifying a C file with Polyspace software, you must know
the locations of the C source file and the include files. You must also know
where you want to store the verification results.

For each project, you decide where to store source files and results. For
example, you can create a project folder, and then in that folder, create
separate folders for the source files, include files, and results.

For this tutorial, prepare a project folder as follows:

1 Create a project folder named polyspace_project.

2 Open polyspace_project, and create the following folders:
® sources

e includes

3 Copy the file example.c from
Polyspace_Install\Examples\Demo_C_Single-File\sources
to
polyspace_project\sources
Polyspace Install is the installation folder.

4 Copy the files include.h and math.h from
Polyspace_Install\Examples\Demo_C_Single-File\sources
to

polyspace_project\includes.
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Opening Polyspace Verification Environment

You use the Polyspace verification environment to create projects, start
verifications, and review verification results.

To open the Polyspace verification environment:

1 Double-click the Polyspace icon (Windows systems).

Note On a Linux® or UNIX® system, use the following command:

/usr/local/Polyspace/PVE/bin/polyspace

2 If you have only Polyspace Client for C/C++ software installed on your
computer, skip this step. If you have both Polyspace Client for C/C++ and
Polyspace Client for Ada products on your system, the Polyspace Language
Selection dialog box opens.

=

Select a language

¥ PolySpace for CIC++

™ PolySpace for Ada

oK I Cancel

3 Select Polyspace for C/C++ and click OK.

The Polyspace Verification Environment opens.
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Specify source files Set target environment Specify
and include folders and check compilation analysis options
]
[ —— = Te]
File Edit Run Review| Options Window Help
%E)BHP} (‘| & %@|% ‘-‘@'Search: - '®H |E Project Manager | - Coding Rules - Run-Time Checks
D Run ¥ . Stop | |2 new result folder Use result folder: |Resu\t_3 - |
-.E]|ﬁ’.|9|1 ‘|@ bChechompllaﬁoﬂ .Stup
E--E example_project [C] Target Environment B
E-3 Source
585 sources Target ceratng systen: Torget procesor tpe: 35
\j example.d|
3 Include Compiler Dialect
- . Aincludes ‘
£+ 5 Verification_1 BL==8
=+ Souree E
| BE® sources Compilation Macros Active Settings
|| example.c + X b3
Configuration )
H . Macro Description Option
H E example_project
217 Result Ignore assembly code [-discard-asm
: B N . Allow negative operand f|r left shifts -allow-negative-operand-n-shift |
13 Result 2 [Verf\caton Completed] ‘Acceptintegral type con|cts Cpermissive-ink L4
! [Verification Completed] Allow language extensior|: -allow-anguage-extensions =
I E options T
-] RTE_px_example_project_L AST_RESULTS.rte g mple_project /Verification_1 / Configuration /
B3 Verification_2 %‘?
E+E3 Source
| BE® sources | Name Value Internal name
i |_°| example.c | analysis options g
13 Configuration | & General
E example_project Send to Polyspace Server -server
- E examp\a_project 1 Add to results repository -add-to-results-repository L
E| 23 Result - - Keep all preliminary results files keep-all-files 1
-3 Result_4 [Verification Completed] Calculate code metrics ~code-metrics
E options [=-Report Generation
: E RTE_py_exa +-Report template name Developer - -report-template
) MIS_RA—_C—repurtxml *~-Output format RTF = -report-output-format
- rules_project [C] - Target/Compilation i

@ Qutput Summary - [C:\PolySpace'polyspace_project\Verification_1\Result_3]
search: 4 +

Class Description File Line Col

t
4 processars have been detected. Taking advantage of multipro...
i rThe generated default DRS XML file “drs-template, xml" can be f... | ‘

Detail:

Information:
example_project for C verification start at Dec 15, 2010 18:54:41

i Verification Statistics Progress Monitor Output Summary

<

' 0% | Ready

Monitor progress and view logs
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By default, the Polyspace Verification Environment displays the Project
Manager perspective. The Project Manager perspective has three main panes.

Use this For...
section...

Project Browser | Specifying:
(upper-left) ® Source files

® Include folders

® Results folder

Configuration Specifying analysis options
(upper-right)

Output Monitoring the progress of a verification, and viewing
(lower-right) status, log messages, and general verification statistics.

You can resize or hide any of these panes. You learn more about the Project
Manager perspective later in this tutorial.

Creating a New Project to Verify the Example C File

You must have a project, saved with file type cfg, to run a verification. In this
part of the tutorial, you create a new project for verifying example.c.

You create a new project by:

® “Opening a New Project” on page 2-7

® “Specifying Source Files and Include Folders” on page 2-10
® “Specifying Target Environment” on page 2-11

® “Specifying Analysis Options” on page 2-12

® “Saving the Project” on page 2-13

Opening a New Project
To open a new project for verifying example.c:
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1 Select File > New Project.

The Polyspace Project — Properties dialog box opens:

— Polyspace Project - Properties @
Project definition and location

Project name: example_project
Version: | 1.0

Author; |username

Default location

Location: | C:\PolySpace\example_project 3

Project language
@ C

C++

ack | Mext | | Finish | | Cancel

2 In the Project name field, enter example project.

3 Clear the Default location check box.

Note Clearing the Default location check box allows you to specify

the location of your project files. In this tutorial, you change the default
location to the project folder that you created in “Preparing Project Folders”
on page 2-4. Changing the default location makes it easier to specify source
files and include folders.
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4 In the Location field, enter or navigate to the project folder that you
created earlier.

In this example, the project folder is C: \Polyspace\polyspace_project.
5 In the Project language section, select C.

6 Click Finish.

The example project opens in the Polyspace verification environment.

File Edit Run Review Options Window Help
%‘ @ [ s “| 9 ™ | % By @ | % 9 .| (7] ‘Search: - '® | | /= Project Manager | -2+ Coding Rules -3 Run-Time Checks
PRun ¥ ’ BatchRun ) Stop |[¥] Create new result folder Use result folder: | - |
" Project Browser <" Configuration - [example_project f Module_1 [ Configuration [ example_project]
& A ‘ =R | | o | + 3 | == P Check Compilation ¥ Stop
EI--@ lexample_project [C] Target Environment
i[E3) Include Target operating system: ~ | Target processor type: |i386 - Edit
EHE5 Module_1
-l Source Compiler Diglect
{3 Configuration
" ceample pecject Diec:
----- & Result
Compilation Macros Active Settings
* X x
Macro Description Option
Ignore assembly code -discard-asm -
Allow negative operand for left shifts -allow-negative-operand-in-shift [Tl
Acceptintegral type conflicts -permissiveink =
Allow language extensions -allowanguage-extensions
Allow non int types for bitfields -allow-non-nt-bitfield
Allow anonymous unions/fstructure fields -allow-unnamed-fields -
% Configuration | -2 Compilation Assistant
% Output Summary
@ Full Lag | ’ Verification Statistics Progress Monitor Output Summary
' 0% | Ready
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Specifying Source Files and Include Folders

To specify the source files and include folders for the verification of example.c:

1 In the Project Browser, select the Source folder.

2 Click the Add source icon * in the upper left the Project Browser.

The Polyspace Project — Add Source Files and Include Folders dialog box

opens.
-~ Polyspace Project - Add Source Files and Include Folders @
Lockin: | |, polyspace_project ) ¥ ?:E Add recursi\tely| “j | + 3
X Jincludes E|<_J example_project [C]
&} J sources EJ _,- Source
Recent Items EE‘ sources
| example.c
E-£5 Indude
! £ C:'Polyspace\polyspace_projectincudes
Desktop
L
My Documents
[
L
Computer
@
Network -
Files of type: | (,c) files only - | Add Include

3 The project folder polyspace_project should appear in Look in. If it does

not, navigate to that folder.

4 Select the sources folder, then click Add Source.

The example.c file appears in the Source tree for example project.
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5 Select the includes folder, then click Add Include.

The includes folder appears in the Include tree for example project.

Note In addition to the include folders you specify, Polyspace software
automatically adds the standard includes to your project.

6 Click Finish to apply the changes and close the dialog box.

The Project Browser now looks like the following graphic.

AR 2| r v |E

EI--*.:',I example_project [C]
Elli:' Source

EI‘E' SOUFCES

----- | example.c

Elli:' Include

. i C:\Polyspace\polyspace_projectiincludes
=3 Module_1

Ellﬂ' Configuration

----- E example_project

- & Result

Specifying Target Environment

Many applications are designed to run on specific target CPUs and operating
systems. Since some run-time errors are dependent on the target, you must
specify the type of CPU and operating system used in the target environment
before running a verification.

The Compilation Assistant window in the top-right section of the Project

Manager perspective allows you to specify the target operating system and
processor type for your application.
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To specify the target environment for this tutorial:

1 In the Target operating system drop-down menu, select
no_predefined_OS.

B Check Compilation 9 Stop

Target Environment

v: Target processor type: :i386 v:

Compiler Dialect

Dialect: | none =

2 In the Target processor type drop down menu, select 1386.

For more information about emulating your target environment, see “Setting
Up a Target”in the Polyspace Products for C/C++ User’s Guide.

Specifying Analysis Options

The Configuration tab in the middle-right section of the Project Manager
perspective allows you to set Analysis options that Polyspace software uses
during the verification process.

Click the Configuration tab to see the Analysis options for the verification.

For this tutorial, you should use the default values for all options.
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Mame Value Internal name
Analysis options
[=-General

-5end to Polyspace Server -zerver

--Add to results repository = -add-to-results-repository

-Keep all preliminary results files = keep-all-files

-Caloulate code metrics = -code-metrics

[=l-Report Generation |
i-Report template name Developer -report-template
Qutput format RTF -repor t-output-format

- Target/Compilation

H--Compliance with standards

H--PrecisionScaling

[
[
[#-Polyspace inner settings
E
[

H--Multitasking

% Configuration | -2+ Compilation Assistantl

For more information about analysis options, see “Options Description” in the

Polyspace Products for C/C++ Reference.

Saving the Project

To save the project, select File > Save.

Polyspace software saves your project using the Project name and Location

you specified when creating the project.
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Running a Verification

® “About Running a Verification Tutorial” on page 3-2

® “Preparing for Verification” on page 3-4

¢ “Launching Server Verification from Project Manager” on page 3-11
¢ “Using Polyspace In One Click to Launch Verification” on page 3-23

¢ “Launching Client Verification from Project Manager” on page 3-30
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About Running a Verification Tutorial

In this section...

“Overview” on page 3-2

“Before You Start” on page 3-3

Overview

Once you have created the project example.cfg, as described in “Creating a
New Project” on page 2-3, you can run the verification.

You can run a verification on a server or a client.

Use...

FOI‘...

Server

¢ Best performance

¢ Large files (more than 800 lines of code, including comments)

Client

® When the server is busy

e Small files

Note Verification on a client takes more time. You might
not be able to use your client computer when a verification is
running on it.

You can start a verification using either the Project Manager or Polyspace In
One Click. With either method, the verification can run on a server or a client.
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Use... For...

Project Manager A basic way to start a verification.

You specify the source files in the project file.
With the project open, you click a button to start
the verification.

Polyspace In One Click | A convenient way to start the verification of
several files which use the same verification
options.

Once you specify the project file containing the
verification options, you specify the source files
by selecting them from a Microsoft Windows
folder. You start the verification by sending the
selected files to Polyspace software.

In this tutorial, you learn how to run a verification on a server and on a client,
and how to start a verification using the Project Manager and Polyspace In
One Click. You verify the file example.c three times using a different method
each time. You use:

® Project Manager to start a verification that runs on a server.

¢ Polyspace In One Click to start a verification that runs on a server.

® Project Manager to start a verification that runs on a client.

Each verification stores the same results in your project. You review these
results in the tutorial Chapter 4, “Reviewing Verification Results”.

Before You Start

Before you start this tutorial, you must complete Chapter 2, “Setting Up a
Polyspace Project”. You use the folders and project file, example.cfg, from
that tutorial.
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Preparing for Verification

In this section...

“Opening the Project” on page 3-4
“Specifying Source Files to Verify” on page 3-5

“Checking for Compilation Problems” on page 3-5

Opening the Project

To run a verification, you must have an open project file. For this tutorial, you
use the project file example.cfg that you created in Chapter 2, “Setting Up a
Polyspace Project”. If example project.cfg is not already open, open it.

To open example project.cfg:
1 If the Polyspace software is not already open, open it.
2 Select File > Open Project.

The Open a Polyspace project file dialog box opens.

3 In the Look in drop-down list box, navigate to polyspace_project.

4 Select example project.cfg.

5 Click Open to open the file and close the dialog box.
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Specifying Source Files to Verify

Each Polyspace project can contain multiple modules. Each of these modules
can verify a specific set of source files using a specific set of analysis options.

Therefore, before you launch a verification, you must specify which files in
your project that you want to verify. In the example project in this tutorial,
there is only one file to verify.

To copy source files to a module:
1 In the Project Browser Source tree, right click example.c.
2 Select Copy Source File to > Module_(1).

The example.c file appears in the Source tree of Module (1).

ALVt +|E
EI,_".I example_project [C]
EI_J Source

EI‘E‘.‘ SOUFCES

S| examplec

=l

El_} Include
L3 CA\Polyspace\polyspace_projectiincludes
&3 Module_1

~IC Source

EHES sources

B

EI_,‘ Configuration

P E example_project

Checking for Compilation Problems

The Compilation Assistant allows you to check your project for compilation
problems before launching a verification. When the Compilation Assistant
detects an error, it reports the problem and suggests possible solutions.

3-5



3 Running a Verification

To check your project for compilation problems:

1 In the Project Browser Source tree, right click the Include folder
(. .\includes), then select Remove. This will cause a compilation error.

SESIE B IR I
Eyf} example_project [C]

£ Source

Elﬁ sources

| example.c

E}@ Include

d Log”
LIE Project Properties Alt+P
EJB Configuration
example_project

...... & Result

2 In the Compilation Assistant window, click Check Compilation.
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“" Configuration - [example_project / Module_1 / Configuration / example_project]

| B Check Compilation | & Stop
Target Environmentif\?

Target operating system:

Target processor type: |i386 - Edit
Compiler Dialect

Compilation Macras Active Settings

+ X X

Macro Description Option
Ignore assembly code -discard-asm
Allow negative operand for left shifts  [-allow-negative-operand-in-shift
Acceptintegral type conflicts -permissivedink
Allow language extensions -allow-anguage-extensions
Allow non int types for bitfields -allow-non-int-bitfield
Allow anonymous unions/structure fields [-allow-unnamed-fields
Code from DOS or Windows filesystem  |-dos
Allow undefined global variables -allow-undef-variables

The software compiles your code and checks for errors, and reports the
results in the Output Summary.

@ Preprocessing Errors: 2 | Filter warnings (0}
Type File Line Message SuggestionRemark Action
§ |example.c |1 |could not open source file "math.h™  |Add indude folder for: math.h - | Add... |

§ |example.c |2 |could not open source file incdude.h™ |Add indude folder for: incude.h - | Add... |

Because you removed the include folder, the software reports a compilation
error for the project, along with suggested solutions for the problem.

3 Select the Suggestion/Remark column to see a list of possible solutions
for the problem.
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@ Preprocessing Errors: 2 | [] Filter warnings {0)

Type File Line Message SuggestionRemark Action

could not open source file "math.h™ [#.dd indude folder for: math.h - | Add...

2 could not open source file “include.h® | [IERN CR Gl iR TNy

Y example.c

Set option: -ignore-missing-headers

In this case, you can either add the missing include file, or set an option
that will attempt to compile the code without the missing include file.

4 Select Set option: -ignore-missing-headers, then click Apply.

5 The software automatically sets the option Ignore missing header files
for your project, and displays the option in the Compilation Assistant
Active Settings table.

Active Settings

X

Description Option
Ignore assembly code -dizcard-azm
Allow negative operand for left shifts  |-allow-negative-operand-in-shift
Accept integral type conflicts -permissive-ink

Allow language extensions -gllow-anguage-extensions
Allow non int types for bitfields -allow-non-int-bitfield

Allow anonymous unionsfstructure fields|-allow-unnamed-fields

Code from DOS or Windows filesystem  |-dos

Allow undefined global variables -gllow-undef-variables

6 Select Check Compilation to check your project again.

The same errors appear, since the code cannot be compiled without
include.h.

7 In the Output Summary window, select Add include folder for:
include.h, then click Add.

The Add Source Files and Include Folders dialog box opens.
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-~ Polyspace Project - Add Source Files and Include Folders @
Look in: i polyspace_project = T ‘-‘:E Add recursively| “j | 1+ &
1 . includes BU example_project [C]
’;} J sources E} = Source
Recent Items BB‘ L hes
|| example.c
2 Indude
! ----- {E3) C:\Polyspace'polyspace_projectincudes
Desktop
¥
My Documents
[
A
Computer
@
Network -
File name: | | Add Source
Files of type: [ (=.) files only - o] Add Indude

8 If necessary, navigate to the polyspace_project folder.
9 Select the includes folder, then click Add Include.
The includes folder appears in the Include tree for example project.
10 Click Finish.

11 Select Check Compilation in the Compilation Assistant to check your
project again.

The message Compilation succeeded appears in the Output Summary.
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@ Output Summary - [C:\Users\srunstro\AppData'Local\Temp'Polyspace 1308948328890\ CompileAssistant] O

@ Compilation succeeded | Filter warnings (0)
-
Type File Line Message Suggestion/Remark Action
i | | |Corn|:lilaﬁon succeeded bmrt a code verification by dicking "Run” in the main toolbar.
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Launching Server Verification from Project Manager

In this section...

“Starting the Verification” on page 3-11

“Troubleshooting a Failed Verification” on page 3-20

“Monitoring Progress of the Verification” on page 3-13

“Removing Verification Results from the Server” on page 3-19

Starting the Verification

In this part of the tutorial, you run the verification on a server.

To start a verification that runs on a server:

1 Select the Send to Polyspace Server check box in the General Analysis

options.

Marme

Analysis options

Value

Internal name

E-General

gsend to Polyspace Server v SEerver

----- Add to results repository [ -add-to-results-repository
----- Keep all preliminary results files [ +eep-al-files
----- Caloulate code metrics [l -code-metrics
[El-Report Generation &
----- Report template name Developer -report-template

----- Output format

RTF

-report-output-format

+-Target/Compilation

+]--Compliance with standards

+-Predsion,/Scaling

[
[
[+--Polyspace inner settings
[
[

+-Multitasking
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2 Click the Run button P Run on the Project Manager toolbar.

Note If you see the message Verification process failed, click OK
and go to “Troubleshooting a Failed Verification” on page 3-20.

The verification has three main phases:

a Checking syntax and semantics (the compile phase). Because Polyspace
software is independent of any particular C compiler, it ensures that
your code is portable, maintainable, and complies with ANSI® standards.

b Generating a main if the Polyspace software does not find a main and
you have selected the Generate a Main option. For more information
about generating a main, see “Main Generator Behavior for Polyspace
Software” in the Polyspace Products for C/C++ Reference.

¢ Analyzing the code for run-time errors and generating color-coded
results.

The compile phase of the verification runs on the client. When the compile
phase is complete:

® You see the message queued on server at the bottom of the Project
Manager perspective. This message indicates that the part of the
verification that takes place on the client is complete. The rest of the
verification runs on the server.

* A message in the Output Summary window gives you the identification
number (Analysis ID) for the verification. For this verification, the
identification number is 1.

Search: £
Class Description File Line Col
i example_project for C verification start at Dec 15, 2010 15:57:15 -
i The generated default DRS ¥ML file "drs-template. xml” can be found in <result_dir... =
i Analysis ID : 1 ped

3 For information on any message in the log, click the message.
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Monitoring Progress of the Verification

There are two ways to monitor the progress of a verification:

¢ Using the Project Manager — allows you to follow the progress of the
verifications you submitted to the server, as well as client verifications.

¢ Using the Queue Manager (Spooler) — allows you to follow the progress
of any verification job in the server queue.

Monitoring Progress Using Project Manager

You can monitor the progress of your verification by viewing the progress
monitor and logs at the bottom of the Project Manager perspective.

4

Intermediate: 100%:
00:00:03

Verification is running on server with ID: 1

LevelD: 100% Levell: 83% Level2 : 0% I Level3d : 0%
00:00:20 00:00:13 00:00:00 00:00:00

1 [ F

The progress monitor highlights the current phase in blue and displays the
amount of time and completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:

1 Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search in
the log box and clicking the left arrows to search backward or the right
arrows to search forward.

2 Click the Verification Statistics tab to display statistics, such as analysis
options, stubbed functions, and the verification checks performed.
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3 Click the Refresh button
progresses.

| to update the display as the verification

4 Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.

Note You can search the logs. In the Search in the log box, enter a
search term and click the left arrows to search backward or the right
arrows to search forward.

Monitoring Progress Using Queue Manager

You monitor the progress of the verification using the Polyspace Queue
Manager (also called the Spooler).

To monitor the verification of Example Project:

1 Double-click the Polyspace Spooler icon on the desktop.

The Polyspace Queue Manager Interface opens.

Polyspace Queue Manager Interface
Operations Help

(=[O =)

D Author Application Results folder CPU Status Date Language
----- 23 |username |example_project |C:\PolySpace\polyspace _project\verification_1\Result_9 |AH-SRUNS... |completed [15-Dec-2010, 16:03:33 |C

24 a a o olySpa olyspa o catio 0 A g D 010, 16:0

------ 25 |username |example_project |C:\PolySpace\polyspace _project\verification_1\Result_11 gueued  |15-Dec-2010, 16:03:21 |C

Connected to Queue Manager AH-SRUNSTRO.dhcp.mathworks.com

User mode
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Tip You can also open the Polyspace Queue Manager Interface by

clicking the Polyspace Queue Manager icon E on the Run-Time Checks
perspective toolbar.

2 Point anywhere in the row for ID 1.

3 Right-click to open the context menu for this verification.
Follow Progress...
View Log File...
Download Results...

Download Results in Mew Polyspace Window...

Download Results and Remove From Queue...
Move Down in Queue

Stop...
Stop and Download Results...

Stop and Remowe From Queue...

Remowve From Queue...

4 Select View log file.

A window opens displaying the last one-hundred lines of the verification.
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[ view Log File (23]

Generating results in a spreadsheet format in C:\FolySpace\FolySpace_ “

Generation complete

v o o o o o o o o o o o ol o ol o o o o ol ol ol ol ol ol oy o oy ol ol o o oy o oy ol o o ol o o e o o o o o o ol o o o ol o o ol o o
L

#%% Spoftware Safety Analysis Level 4 done

L

v o o o o o o o o o o o ol o ol o o o o ol ol ol ol ol ol oy o oy ol ol o o oy o oy ol o o ol o o e o o o o o o ol o o o ol o o ol o o
Ending at: Dec 15, 2010 16:4:26

User time for pass4: 00:00:02.34 (2.3real, 2.3u + 0s)

Generating remote file
Done
User time for polyspace-c: 00:00:49.27 (49.3real, 49.3u + 0s (0.1lgc))

"R

#*#% EFnd of Polyspace Verifier analysis
LA i
4| 1 §

Cloze

1 [

5 Click Close to close the window.
6 Select Follow Progress from the context menu.

The Progress Monitor opens.
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dceTor

File Edit Window Help
Progress Monitor

Intermediate; 100%: Leveld: 100% Levell: 100% Level2: 100% Level3: 0% |' Level4 : 0% || Total
00:00:03 00:00: 21 00:00:14 00:00:03 00:00:01 00:00:00 00:00:41

"% Verification Statistics

.

s

Number of files 11
Number of lines : 248

Lm] »

Number of lines without comments @ 136

Automatically stubbed pure functions :

random_int
random_float
get_bus_status

Stats on aliases :

Some stats on aliases computation:
Mumber of invisibles: i
Mumber of alias reads: 0
Mumber of pma writes: 5 -

4 | 1 | »
@ Full Log h Verification Statistics Output Summary |

You can monitor the progress of the verification by watching the progress
bar and viewing the logs at the bottom of the window. The progress monitor
highlights the current phase in blue and displays the amount of time and
completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:
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e (Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search
in the log box and clicking the left arrows to search backward or the
right arrows to search forward.

e (Click the Verification Statistics tab to display statistics, such
as analysis options, stubbed functions, and the verification checks
performed.

¢ (Click the Refresh button
progresses.

to update the display as the verification

¢ (Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.

Note You can search the logs. In the Search in the log box, enter a
search term and click the left arrows to search backward or the right
arrows to search forward.

7 Select File > Quit to close the progress window.
8 Wait for the verification to finish.

When the verification is complete, the status in the Polyspace Queue
Manager Interface changes from running to completed.

Peolyspace Queue Manager Interface E\@

Operations Help

D Author Application Results folder CPU Status Date Language
----- 23 |username |example_project |C:\PolySpace\polyspace _project\verification_1\Result_9 |AH-SRUNS... |completed [15-Dec-2010, 16:03:33 |C

e 24 = a ] 0 = 0 = ] catio 0 A o d O 010, 16:04

25 |username |example_project |C:\PolySpace'palyspace_project\verification_1\Result_11 [AH-SRUNS. .. |completed |15-Dec-2010, 16:05:13 |C

Connected to Queue Manager AH-SRUNSTRO.dhcp.mathworks.com User mode
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Removing Verification Results from the Server

At the end of a server verification, the server automatically downloads
verification results to the results folder specified in the project. You do not
need to manually download your results.

Note You can manually download verification results to another location on
your client system, or to other client systems.

Verification results remain on the server until you remove them. Once your
results have been downloaded to the client, you can remove them from the
server queue.

To remove your results from the server:

1 In the Polyspace Queue Manager Interface, right-click the verification,
and select Remove From Queue.

A dialog box opens to confirm that you want to remove the verification
from the queue.

Remowve From Queue @

'jO:' Do you really want te remove the selected verification(s) from the queue?

Yes | | MNo

2 Click Yes.

Note To download the results and remove the verification from the queue,
right-click the verification and select Download Results And Remove
From Queue. If you download results before the verification is complete,
you get partial results and the verification continues.

3 Select Operations > Exit to close the Polyspace Queue Manager Interface.
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Once the results are on your client, you can review them using the Run-Time
Checks perspective. You review results from the verification in Chapter 4,
“Reviewing Verification Results”.

Troubleshooting a Failed Verification

When you see a message that the verification failed, it indicates that
Polyspace software could not perform the verification. The following sections
present some possible reasons for a failed verification.

Hardware Does Not Meet Requirements

If your computer does not have the minimum hardware requirements. the
verification fails. For information about the hardware requirements, go to:

www.mathworks.com/products/polyspaceclientc/requirements.html.

To determine if this is the cause of the failed verification, search the log for
the message:

Errors found when verifying host configuration.
You can:

e Upgrade your computer to meet the minimal requirements.

¢ In the General section of the Analysis options, select the Continue with
current configuration option and run the verification again.

You Did Not Specify the Location of Include Files

If you see a message in the log, such as the following, either the files are
missing or you did not specify the location of include files.

include.h: No such file or folder

For information on how to specify the location of include files, see “Creating a
New Project to Verify the Example C File” on page 2-7.


http://www.mathworks.com/products/polyspaceclientc/requirements.html
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Polyspace Software Cannot Find the Server
If you see the following message in the log, Polyspace software cannot find
the server.

Error: Unknown host

Polyspace software uses information in the preferences to locate the server.
To find the server information in the preferences:

1 Select Options > Preferences.

2 Select the Server Configuration tab.
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=+ Polyspace Preferences IEI
| Tools Menu | Review statuses | Aggistant configuration | Mizcellaneous | Character encoding
Server configuration | Results folder | Editors | Generic targets

Remote configuration

Mote: Send to Polyspace server option is mandatory when the project contains multitasking options.
The multitasking options will be ignored otherwize.

@ Automatically detect the remote server

(7 Use the following server and port: [ -0 12427

The server name Tocalhost”™ can be used if the server is the local machine.
Metrics configuration

Polyspace Metrics allows you, through a web browser, to drill down to specific coding rule violations and run-time checks. If you
want to view or dassify these items as defects within Polyspace, you dick the item. Polyspace opens with the spedfic item
displayed. However, this requires the downloading of result files from the Polyspace Metrics web interface to a locally accessible
folder. On this tab, you specify how result files are downloaded from the Polyspace Metrics web interface and when justifications
are saved in the Polyspace Metrics database.

If you select this check box, results are downloaded to the folder where the verification was launched. If this launch folder does
not exist, results are downloaded to the location spedified in the Folder field.
Otherwise, a file browser allows you to select the download location.

Download results automatically
Folder: Vinfrnas-00-ah'srunstro\Documents\Polyspace_Workspace\DownloadedResults

If you select this check box, the save action (Ctrl+5) will save your justifications in the local results folder and the Polyspace
Metrics database. If you do not select this chedk box, the save action will save justifications in the local results folder only. If you
want to save justifications in the Polyspace Metrics database, dick the 'Save in database' button.

Save justifications in the Polyspace Metrics database

Port used to communicate with the Polyspace Metrics web interface.

Port number: 12428

The Polyspace Metrics web interface URL is defined as follow: http://<remoteServer >; <porthumber >,
The remote server can be configured above.

Web server port number: 8080

’ oK ]| Apply |[ Cancel

By default, Polyspace software automatically finds the server. You can
specify the server by selecting Use the following server and port and
providing the server name and port. For information about setting up a
server, see the Polyspace Installation Guide.
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Using Polyspace In One Click to Launch Verification

In this section...

“Overview of Polyspace In One Click” on page 3-23
“Setting the Active Project” on page 3-23

“Sending Files to Polyspace Software” on page 3-25

Overview of Polyspace In One Click

In a Microsoft Windows environment, Polyspace software provides a
convenient way to streamline your work when you want to verify several
files using the same set of options. Once you have set up a project file that
has the options that you want, you designate that project as the active project,
and then send the source files to Polyspace software for verification. You do
not have to update the project with source file information. This process is
called Polyspace In One Click.

In this part of the tutorial, using Polyspace In One Click, you learn how to:

1 Set the active project.

2 Send files to Polyspace software for verification.

Setting the Active Project

The active project is the project that Polyspace In One Click uses to verify the
files that you select. Once you have set an active project, it remains active
until you change the active project. Polyspace software uses the analysis
options from the project; it does not use the source files or results folder from

the project.
To set the active project:

1 In the taskbar area of your Windows desktop, right-click the Polyspace In
One Click icon:

The context menu appears.
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Set active project 3

Polyspace - Run-Time Checks
Polyspace - Project Manager

£ E

Spooler
Help 3

Exit

2 Select Set active project > Browse.

The Please set an active project dialog box opens.

Please set an active project. IEI
@Qv| )« O5Disk (C:) » PolySpace » polyspace_project » v|¢¢| Search poly ,Ol
Organize * MNew folder # >~ [ @

- s includes
18 Computer

| sources
&, 0SDisk (C3)

5 Adoc_jas (\\jana:
5® shared (\infnas-
¥ win3Zs (\infnas-
¥ srunstro (infna{
& bats (\infnas-01)
58 hub (\DFS-01-A|~
# ges (\Winfnas-01-
5 srunstro (math

) Verification_1

example_project.cfg

, mathwaorks -

- ’Polyspace configuration files (* v]

| |

File name: example_project.cfg

[ Open Cancel ]

3 Navigate to polyspace_project.

4 Select example project.cfg.
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5 Click Open to apply the changes and close the dialog box.

Sending Files to Polyspace Software

You can send several files to Polyspace software for verification. For this
tutorial, you send one file, example.c.

To send example.c to Polyspace software for verification:
1 Navigate to the folder polyspace project\sources.
2 Right-click the file example.c.

The context menu appears.

[ame |

Open

Edit

Cpen with wordPad
ca Scan For viruses. ..

Open ith b
B WinZip 3

Send Ta »

Cuk

Copy

Create Sharkout
Delete
Rename

Propetties

3 Select Send To > Polyspace.
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Marme

I Size | Tvpe

e
Open
Edit
Cpen with WordPad
2 Scan for viruses, ..
Cpen Wikh
&) WinZip

3
3

£ ] Compressed (zipped) Folder

Cuk
Copy

Create Sharkcuk
Delete
Renarme

Properties

SKE CFile

@ Desktop (create shorbout)
E Fax Destination wia RightFAx
(# Macromedia FreeHand My
| Mail Recipient

,D MMy Documents
PolySpace

4L 314 Floppy (A2)

The Polyspace basic settings dialog box appears.
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E Polyspace basic settings [ C | E\@

Settings

Precision |02

Passes I Pass2 (Software Safety Analysis level j

Results folder |C:\Poh'5pace\poh'space _project

Verification Mode Settings

Variables written before loop INone

Functions called in loop I.NI

Functions called before loop |

Scope

C\PolySpace'\polyspace_projectsources example .. +

¢l Send to Polyspace Server ¥ Startl @Cannel |
4 Make sure that the Results folder is polyspace project.

Settings

Precision |02 j
Passes | Pass2 (Software Safety Analysis level 2) x|
Results folder |':3"'-PDWSPECE"ﬂDh'SDaCEJJFU]ECt |
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5 If the Send to Polyspace Server option is not already selected, select it.

6 Leave the default values for the other parameters.
Click Start.

The verification log opens.

ChPolySpace\polyspace_project EI@
= @ ~

done. -
Generating remote fie
Done

*iE

=% [ sources verification done
tEE

Ending at: Dec 15, 2010 16:24:15

User time for compilation: 00:00:08.42 (8.4real, 8.4u + 0s (0.1gc))
User time for polyspace-c: 00:00:08.47 (8.5real, 8.5u + 0= (0.1gc))
tkE

== End of Polyspace WVerifier analysis

Ttk

Adding the verification to the queue. ..

Queue Manager server: AH-SRUNSTRO.dhcp.mathworks.com
Transfer completed.

Analysis ID ;26

The verification has been queued. You may follow its progress using the Queue Manager Interface. -

m

4 1 3

The code verfication completed successfully

The compile phase of the verification runs on the client. When the compile
phase is complete:
® You see the following message in the log:

End of Polyspace Verifier analysis

* A message in the log states that the verification was transferred to the
server and gives you the identification number (Analysis ID) for the
verification. For this verification, the identification number is 1.
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e Monitor the verification using the Spooler. For information on using the
Spooler to monitor a verification on a server, see “Monitoring Progress
Using Queue Manager” on page 3-14.

e When the verification is complete, download the results to
polyspace _project\results. For information on downloading results
from a server to a client, see “Removing Verification Results from the
Server” on page 3-19

You review the results in Chapter 4, “Reviewing Verification Results”.
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Launching Client Verification from Project Manager

In this section...

“Starting the Verification” on page 3-30
“Monitoring the Progress of the Verification” on page 3-32
“Completing Verification” on page 3-33

“Stopping the Verification Before It is Complete” on page 3-34

Starting the Verification

For the best performance, run verifications on a server. If the server is busy
or you want to verify a small file, you can run a verification on a client.

Note Because a verification on a client can process only a limited number
of variable assignments and function calls, the source code should have no
more than 800 lines of code.

To start a verification that runs on a client:

1 If the project example_project.cfg is not already open, open the project.

For information about opening a project, see “Preparing for Verification”
on page 3-4.

2 Clear the Send to Polyspace Server check box in the General Analysis
options.
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Configuration - [example_project / Module_1 / Configuration [ example_project] o 2=

Mame

Analysis options

Value

Internal name

El-General

e cend to Polyspace Server

<

-Server

----- Add to results repository -add-to-resultsrepository
----- Keep all preliminary results files -keep-al-files
----- Calculate code metrics -code-metrics
[El-Report Generation
----- Report template name Developer -report-template

----- Cutput format

RTF

-report-output-format

+-Target/Compilation

+--Compliance with standards

+-Predsion/Scaling

[
[
[+-Polyspace inner settings
[
[

+--Multitasking

3 Click the Run button lml on the Project Manager toolbar.

4 If you see a caution that Polyspace software will remove existing results
from the results folder, click Yes to continue and close the message dialog

box.

The Output Summary and Progress Monitor windows become active,
allowing you to monitor the progress of the verification.

Note If you see the message Verification process failed, click OK

and go to “Troubleshooting a Failed Verification” on page 3-20.
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Monitoring the Progress of the Verification

You can monitor the progress of the verification by viewing the progress
monitor and logs at the bottom of the Project Manager perspective.

Verification is running on server with ID; 1
Intermediate: 100%: Leveld: 100%: Levell: 89% Level2 : 0% I Level3 : 0%
00:00:03 00:00:20 00:00:13 00:00:00 00:00:00
4 1 | }

The progress monitor highlights the current phase in blue and displays the
amount of time and completion percentage for that phase.

The logs report additional information about the progress of the verification.
To view a log, click the button for that log. The information appears in the
log display area at the bottom of the Project Manager window. Follow the
next steps to view the logs:

1 Click the Output Summary tab to display compile phase messages and
errors. You can search the log by entering search terms in the Search in
the log box and clicking the left arrows to search backward or the right
arrows to search forward.

2 Click the Verification Statistics tab to display statistics, such as analysis
options, stubbed functions, and the verification checks performed.

3 Click the Refresh button _*
progresses.

i1to update the display as the verification

4 Click the Full Log tab to display messages, errors, and statistics for all
phases of the verification.
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Note You can search the logs. In the Search in the log box, enter a
search term and click the left arrows to search backward or the right
arrows to search forward.

Completing Verification

When the verification is complete, the message “Verification Completed”
appears at the bottom of the Project Manager window, and the results appear
in the Project Browser.

-I£3|[ﬁ‘l| ER A=

E 1._*} example_project [C]
E} IE'..' Source
B ’E‘ SOUrces
: s | example.c
E‘ Include
----- = "uncludes
B &
EI E‘ Source
B E‘ SOUrCes
- || example.c
El E‘ Configuration
124 example_project
=8 3 Result
EFE' Result_2 [Verification Completed]
{E options

------ RTE_px_example_project LAST_RESULTSate

In the tutorial Chapter 4, “Reviewing Verification Results”, you open the
Run-Time Checks perspective and review the verification results.
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Stopping the Verification Before It is Complete

You can stop the verification before it is complete. If you stop the verification,
results are incomplete. If you start another verification, the verification starts
over from the beginning.

To stop a verification:

1 Click the Stop button @ STDF on the Project Manager toolbar.

A warning dialog box opens.

-

Polyspace Verification Warning @

! . Do you really want to stop the current execution?
L1

| Yes | | Mo ‘

2 Click Yes.

The verification stops and the message Verification process stopped
appears.

3 Click OK to close the Message dialog box.

Note Closing the Polyspace verification environment window does not stop
the verification. To resume display of the verification progress, start the
Polyspace software and open the project.
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Results

* “About Reviewing Verification Results Tutorial” on page 4-2
® “Opening Verification Results” on page 4-3

e “Exploring Run-Time Checks Perspective” on page 4-4

e “Reviewing Results” on page 4-9

¢ “Reviewing Results Systematically” on page 4-25

e “Automatically Testing Unproven Code” on page 4-31

® “Generating Reports of Verification Results” on page 4-32
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About Reviewing Verification Results Tutorial

In this section...

“Overview” on page 4-2

“Before You Start” on page 4-2

Overview

In the previous tutorial, Chapter 3, “Running a Verification” , you completed a
verification of example.c. In this tutorial, you explore the verification results.

The Polyspace verification environment contains a Run-Time Checks
perspective that you use to review results. In this tutorial, you learn:
1 How to use the Run-Time Checks perspective, including how to:
® Open the Run-Time Checks perspective and view verification results.
e Explore results in expert mode.
® Explore results in assistant mode.

® Generate reports.

2 How to interpret the color-coding that Polyspace software uses to identify
the severity of an error.

3 How to find the location of an error in the source code.

Before You Start

Before starting this tutorial, be sure to complete the tutorial Chapter 3,
“Running a Verification”.

In this tutorial, you use the verification results in this file:

polyspace_project\Verification_(1)\Result_(1)\
RTE_px_example_project LAST_RESULTS.rte.
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Opening Verification Results

In this section...

“Opening Run-Time Checks Perspective” on page 4-3

“Opening Verification Results” on page 4-3

Opening Run-Time Checks Perspective

You use the Run-Time Checks perspective to review verification results.

To open the Run-Time Checks perspective:

<. Bun-Time Checks | .

¢ Select the Run Time Checks button in the Polyspace

Verification Environment toolbar.

Opening Verification Results
To open the verification results:

1 Select File > Open Result.
The Please select a file dialog box opens.
2 Navigate to the results folder:
polyspace_project\Module_(1)\Result_(1).
3 Select the file RTE_px_example project LAST RESULTS.rte.
4 Click Open.

The results appear in the Run-Time Checks perspective.

Note You can also open results from the Project Manager perspective by
double-clicking the results file in the Project Browser.

4-3



4 Reviewing Verification Results

Exploring Run-Time Checks Perspective

In this section...

“Overview” on page 4-4

“Reviewing the Run-Time Checks Pane” on page 4-6

Overview
The Run-Time Checks perspective looks like the following figure.
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Check details

Review statistics

File Edit Run

Review Options Window Help

T EEEE BRI

|C E" @-|5eamh:|

~ | 45 [ Case sensitve[[] whole word ¥

| |5 Project Man

BEHE |5 [Metodologyrerc

v]E’44 P S

< Run-Time Checks

“7~ Chedc Review

Review Statistics

RTE c_ |5 oaLLs e
T %% || x 1] o= "¢ Coding review progress
" ¥ i ed NTC justified / to justify 0/4 0
Pt 3| example.c / Recursion_caller /line 157 / column 5 » | [Re
ural entities T ? Red justified / to justify 0/8 9
L Dema_C (cov: 82%, unp: 1/48) 8 18 |259| Becursion{ sx ); // always encounters a division by zero -lGray justified / to justfy o6 o
Eexample.c 4 2 |83 || klassification Status Justified “|Orange justified / to justify 0/18 [i]
2 |10 = -] Software reliability indicator 259f297 87|
Non_infinite_Loop () 11 | | |comment
Pointer_Arithmetic { } 1 19
1 3 -2 Expanded Source Code | § Review Statistics
RO - source
ErRecursion_caller () 1 4 |||[example.c| _polyspace_stdstubs.c | 4
bl IRV.0 1
Call L
F NIVL3 1 144 2 ine
 NIVL2 1 145 if (*depth £ 50 T " prey
— t_stubs_0.random_int
i - ! e : b exsmple Recursion 157
o 1 147 Recursion(depth):
L] 148 y b pst_stubs_O.random_int 162
E}-Square_Root(} i S 1ae ¥ example Recursion 184
o IRV 1 150 4 =xample RTE 238
e NIV 1 151  static woid Recursion_caller (void)
% sTD_LIEBS 1 152 { int x=randow int();
" NIVL2 1 iii o« mn ] +
wongd OVFLZ 1
i 155 if ((x2-4) & (x £ -1)) =" Vaniabl
[H-S¢ Root, 8 - -
quare_Root_conv () 156 ( p——
EJ-Unreschable_Cods () = 157 Becursion| &x ); 4/ always encounters a division by :
Bg= 1|2 158 3 Variables Detsiled "
[E-initislisaticns 1|41 153
H-main.c 2 = |a|]] 80 [ initialisations.am pumh!h]H|
-single_file_analysis.c 2 = leo|ffi6L % =10: [ initialisatians. curent_data pointer to
162 if (random int() > 0) - initialisaticns first_psiload int 22
[-tasis o 2|2l 13 (
[ initialisations secend_psiload int 22
B-tass2 o 1|18 164 Recursion{ &x J: /¥ never encounters a division by at B initialisations tab ane0.9)
B_polyspace_stdstubs.c igé ' [ single_file_analysis.output_v1 int &
« [ L] 3 | } ‘ + | | Bsingle_file_analysis output_ve int 22
{-3- Run-Time Checfs J 2 Assistzntchedsl 4 310 I »
b 0% .I Dema_C Source file: example.c examplejc Line: 157 Column: 5
Run-time checks Source code Variable access Call hierarchy

The Run-Time Checks perspective has six sections below the toolbar. Each
section provides a different view of the results. The following table describes
these views.
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This Pane...

Displays...

Run-Time Checks
(Procedural entities view)

List of the checks (diagnostics) for
each file and function in the project

Source
(Source code view)

Source code for a selected check in
the procedural entities view

Review Statistics
(Coding review progress view)

Statistics about the review progress
for checks with the same type and
category as the selected check

Check Review
(Selected check view)

Details about the selected check

Variable Access
(Variables view )

Information about global variables
declared in the source code

Call Hierarchy
(Call tree view)

Tree structure of function calls

You can resize or hide any of these sections. You learn more about the
Run-Time Checks perspective later in this tutorial.

Reviewing the Run-Time Checks Pane

The Run-Time Checks pane displays a table with information about the
diagnostics for each file in the project. The Run-Time Checks pane is also

called the Procedural entities view

When you first open the results file from the verification of example.c, you

see the following procedural entities.
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RTE

W

Y| % v |°w

Procedural entities X +|Lline Col ®|Details

- T - | [

[Hexample.c 4|z 69 1 20 |example.c
[H-initialisations.c 37 1 37 [initialisaticns.c
[H-main.c 2 8 1 79 |main.c
[H-zingle_file_analysis.c 2|2 74| 1 91 kingle_file_analysis.c
[H-tasks1.c 1 0 |tasis1.c

[H-tasksZ o 1 0 fesisZ.c
[H__polyspace__stdstubs.c 1 0 |__polyspace__stdstubs.c

The file example.c is red because it has a run-time error. Polyspace software
assigns each file the color of the most severe error found in that file. The first
column of the table in the Procedural Entities view is the procedural entity
(the file or function). The following table describes some of the other columns
in the procedural entities view.

Column Indicates

Heading

| 7 I Number of red checks (operations where an error always
d occurs)

Number of gray checks (unreachable code)

Number of orange checks (warnings for operations where
an error might occur)

Number of green checks (operations where an error never
occurs)

Selectivity of the verification (percentage of checks that are
not orange)
This is an indication of the level of proof.

o | | 1 | 1

Note You can select which columns appear in the procedural entities view
by editing the preferences.
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What you select in the procedural entities view determines what you see in
the other views. In the following examples, you learn how to use the views
and how they interact.
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Reviewing Results

In this section...

“What are Review Levels?” on page 4-9

“Displaying All Checks” on page 4-10

“Reviewing All Checks” on page 4-10

“Reviewing Additional Examples of Checks” on page 4-16
“Filtering Checks” on page 4-21

What are Review Levels?

To facilitate your review of verification results, Polyspace allows you to control
the type and number of orange checks displayed in the Procedural entities
and Source views of the Run-Time Checks perspective. There are five levels
at which you can review your results:

® 0 — The software displays red and gray checks. In addition, you can
configure the software to displays orange checks that are potential run-time
errors. Through the Polyspace Preferences > Review Configuration
tab, specify the categories of potential run-time errors that you want the
software to display. By default, the software does not display any orange
checks at this level. See “Reviewing Checks at Level 0” on page 4-25.

This level i1s suitable for the review of fresh code.

e 1, 2, and 3 — The software displays red, gray, and green checks. In
addition, the software displays orange checks according to values specified
on the Polyspace Preferences > Review Configuration. You can use
either a predefined methodology or a custom methodology to specify the
number of orange checks per check category. See “Reviewing Checks at
Levels 1, 2, and 3” on page 4-26.

For a predefined methodology, these levels are suitable for reviews at the
following stages of the development process.
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Level Development Stage
1 Fresh code

2 Unit tested code

3 Code Review

e All — In addition to red, gray, and green checks, the software displays all
orange checks. Use this level when you want to carry out an exhaustive
review of your verification results. See “Reviewing All Checks” on page
4-10.

The toolbar in the Run-Time Checks perspective provides controls specific
to review levels.

T 5 [Methodology for c - M4 b

The controls include:

e A slider for selecting the review level — 0, 1, 2, 3, or A1l1l. By default, the
Run-Times Checks perspective opens at level 1.

* A menu for selecting the review methodology for levels 1, 2, and 3.

® Arrows for navigating through checks.

Displaying All Checks

By default, the Run-Time Checks perspective opens at level 1. To display all
checks in the Procedural entities view, move the Review Level slider to Al11.

Reviewing All Checks

In this part of the tutorial, you learn how to use the Run-Time Checks
perspective to examine verification checks. This part of the tutorial covers:
e “Selecting a Check to Review” on page 4-11

® “Displaying the Calling Sequence” on page 4-13

¢ “Tracking Review Progress” on page 4-13
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Selecting a Check to Review

In the procedural entities view, example.c is red, indicating that this file has
at least one red check. To review a red check in example.c:

1 In the procedural entities section of the Run-Time Checks pane, expand

example.c.

2 Expand the red procedure Pointer Arithmetic().

A color-coded list of the checks performed on Pointer_ Arithmetic() opens.

[-Painter_Arithmetic { )
----- ~F NIVL.5
----- ' NIVL3
..... @ OVFL.4

89
94
54
94

=] [ Ry
DCI XX

@

95

example.c

Local variable is initialized [type:
Local variable is initialized {type:

Operation [+] on scalar does not overflow in INT22 range

FPointer is within its bounds
Fointer is initialized

Pointer is initialized

Error : pointer is outside its bounds

Fointer is initialized

Unreachable code

Local varisble is initislized (type:

Warning : pointer may be outside its bounds

Pointer is initialized

Local varisble is initislized (type:
Local variable is initialized (type:

Local variable is initialized (type:

Fointer is initialized

Local variable is initialized (type:

Pointer is within its bounds

Pointer is initialized

int 32)
int 32)

int 32)

int 32)
int 32)
int 32)

int 32)

In the list of checks, each item has an acronym and a number. The acronym
identifies the check type. For example, in IDP.9, IDP stands for Illegal

Dereferenced Pointer. For more information, see “Check Descriptions for C
Code” in the Polyspace Products for C/C++ Reference.

3 Click the red IDP.9.

The Source pane displays the section of source code where this error occurs.
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Examph.c|

9z
93
94
95
=1
a7
a3
99
1aoa
101
10z

int i, *p = array:

if(get_bus_status() > 0]

i
if(get o0il pressure() > 0)

[

103 {

104 po= 5: /% Out of boundsz */

105 3

106 else

107 {

105 14+

109 1

110 3 r
' i | b

4 At line 104 of the code, click the red code.

An error message box opens indicating that when the pointer p is
dereferenced, it is outside of its bounds. At line 92, p points to the start of
array which has 100 elements. The for loop starting at line 94 initializes
the elements of array to 0. This for loop leaves p pointing to the location
after the last element of array
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Displaying the Calling Sequence

You can display the calling sequence that leads to the code associated

with a check. To see the calling sequence for the red IDP.9 check in
Pointer_Arithmetic():

1 Expand Pointer_Arithmetic().

2 Click the red IDP.9.

E
3 Click the call graph button ii‘ in the Check Review toolbar.

A window displays the call graph.

_

@ '[:_|' 95% - U iy

Demo_C - Acce...is.c output_v7 | Demo_C - Call...ithmetic.IDP.9 4 B
main.c example.c example.c example.c
main RTE Pointer_Arithmetic IoP.9

The code associated with IDP.9 is in Pointer_Arithmetic. The generated
main function calls RTE, which calls Pointer_Arithmetic.

Tracking Review Progress

You can keep track of the checks that you have reviewed by marking them. To
mark that you have reviewed the red IDP.9 check in Pointer_Arithmetic():

1 Expand Pointer_Arithmetic().

2 Click the red IDP.9.

The Review Statistics pane displays a table with statistics about the review
progress for that category and severity of error.
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4-14

Coding review progress Count  Progr...
Red IDP justified | to justify 0/1 0
Red justified [ to justify 0/8 0
Gray justified / to justify 0/e 0
Orange justified f to justify 0,20 0
Software reliability indicator 215/249 86

-2 Expanded Source Code | [l Review Statistics

The Count column displays a ratio and the Progress column displays

the equivalent percentage.

The first row displays the ratio of justified checks to total checks that have
the same color and category as the current check. In this example, the
first row displays the ratio of reviewed red IDP checks to total red IDP

errors in the project.

The second row displays the ratio of justified checks to total checks that
have the same color as the current check. In this example, this ratio is the
ratio of red errors reviewed to total red errors in the project.

The last row displays the ratio of the number of green checks to the total
number of checks, providing an indicator of the reliability of the software.

Information about the current check (the red IDP.9) appears in the Check

Review pane (selected check view).

St} == &

example.c / Pointer_Arithmetic  line 104  column 10
#po= 5; /* Qut of bounds */

Classification Status Justified
| = [E

Comment

Error : pointer is outside its bounds
dereference of wvariable 'p' (pointer to int 32, size: 32 bita):
pointer iz not null
points to 4 bytes at offset 400 in buffer of 400 bytes, soc is cutside bounds
may point to variable or field of variable in: {[Pointer Arithmetic:array}
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3 After you review the check, select a Classification to describe the severity
of the issue:

® High
® Medium
® | ow

® Not a defect

4 Select a Status to describe how you intend to address the issue:
® Fix
® Improve
e Investigate
® Justify with annotations
® No Action Planned
® Other
® Restart with different options

® Undecided

Note You can also define your own statuses. See “Defining Custom Status

”

5 In the comment box, enter additional information about the check.
6 Select the check box to indicate that you have justified this check.

The Coding review progress part of the window updates the ratios of
errors reviewed to total errors.
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Coding review progress Count Progress
Red IDP justified / to justify 11 100
Red justified / to justify 1/8 12
Gray justified / to justify 06 0
Crange justified [ to justify 0,20 0
Software reliability indicator 215/249 a6

-2 Expanded Source Code | fi) Review Statistics

Reviewing Additional Examples of Checks
In this part of the tutorial, you learn about other types and categories of

errors by reviewing the following examples in example.c:
¢ “Example: Unreachable Code” on page 4-17

e “Example: Arithmetic Error” on page 4-18

e “Example: A Function with No Errors” on page 4-19

e “Example: Division by Zero” on page 4-19
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Example: Unreachable Code
Unreachable code is code that never executes. Polyspace software displays

unreachable code in gray. In the following example, you look at an example
of unreachable code.

1 In Procedural Entities, click Unreachable Code().

The source code view displays the source code for this function.

example.c 4 B
196 -
197

195

199 static void Unreachable Code(woid)

200 /% Here we demonstrate Polyspace Werifier's ability to

201 identify unreachahle sections of code due to the

202 walue constraints placed on the wariables.

Z03 i

z04 ! int ¥ = randon int();

Z05 int ¥ = randon int():

Z06

207 if (x> ¥

208 {

203 X o= H - ¥

210 if iz < 0 £l
z11 1

21z x=x+1

213

4|

L1} 2

2 Examine the source code.

At line 210, the condition x < 0 is always false. The curly bracket { is gray
because the branch is never executed.
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Example: Arithmetic Error
In the following example, Polyspace software detects a memory corruption
error:

1 In the Procedural entities view, expand the red Square_Root () function.

The source code view displays the source code for this function.

(“sowce - ORX

Example.c| 4 F B
-

179 static void Jgquare Foot conv (double alpha, float *heta pt)

180 % Perform arithmetic cohverzion of alpha to beta +/

18l {

laz heta pt = (float)({1.5 + cos{alpha))/5.0);

1a83 1

154

155 gtatic woid 3quare Root (woid)

186 !

157 double alpha = randow float(]);

1588 float bhetar

153 float gamma; |

190 E

191 druare Root_conw (alpha, sbheta);

192

193 gawma = [(float)sgrt(beta - 0.75); F* always sqgrtinegative

194 1 -

4| 1 | b

2 Examine the source code.

Because beta is always less than 0.75, the argument to the sqrt () function
at line 193 is always negative.
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Example: A Function with No Errors

In the following example, Polyspace software verifies code with a large
number of iterations, and determines that the loop terminates and a variable
does not overflow:

1 In Procedural entities, click the green Non_Infinite Loop() function.

The source code view displays the source code for this function.

20LMCE O o
Example.c| 4 [ E
66 static int Non Infinite Loop (woid) -
67 ! const int big = 1073741821 ; /% 2%%30-3 +/

G int x=0, ¥=0;

69

70 while (1) 3
71

72 {

73 if (¥ > big) { break:}

74 X o=x+ 2

75 ¥=x /%

76 1

77

TG ¥ == J 100;

79 return v;

aao 3 -
4 | 1] [ 3

2 Examine the source code. The variable x never overflows because the while
loop at line 70 terminates before x can overflow.

Example: Division by Zero
In the following example, Polyspace software detects division by zero:

1 In Procedural entities, expand Recursion().

The source code view displays the source code for this function.
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example.c| 4 - B3

137
138
139
140
141
142
143
144
145
146
147
145
149

static woid Recursion (int® depth)

A% if depth<0, recursion will lead to division by zero */
! float adwvance:

*depth = *depth + 1;
advance = 1.0f/(float) (*depth);: /% potential division by zera */

if (*depth < 50)
{
Recursion(depth) ;

'

static void Recurzion caller(wvoid)
{ int x=random int(); —

m

if ({xx-4) &6 (x £ -1)) &
i

Fecursion( &x 1: /4 always encounters a diwvision by zero

® = 10;
if (random_int() > 0)
i

Recursion( &x 1: S* never encounters a division by zero #/

[l | 2

2 Examine the Recursion() function.

When Recursion() is called with depth less than zero, the code at line 142
results in division by zero. The orange color indicates that this operation is

a potential error (depending on the value of depth).

3 Examine the red Recursion_caller function.

The first call to Recursion() at line 157 is red because it calls

Recursion() with depth less than zero, causing a division by zero. The
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second call to Recursion() at line 164 does not cause division by zero
because it calls Recursion() with depth greater than zero.

Filtering Checks

You can filter the checks that you see in the Run-Time Checks perspective so
that you can focus on certain checks. Polyspace software allows you to filter
your results in several ways. You can filter by:

® Check category (ZDV, IDP, NIP, etc.)
e (Color of check (gray, orange, green)
e Justified or unjustified

® (lassification

® Status

To filter checks, select one of the filter buttons in the Run-Time checks toolbar.

| % | % |5 |

Tip The tooltip for a filter button describes what filter the button activates.

Example: Filtering IRV Checks

You can use an RTE filter to hide a given check category, such as IRV. When
a filter is enabled, you do not see that check category.

To filter IRV checks:

1 Expand Square_Root ().

Square_Root () has five checks: four are green and one is red.
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E}--Squs'e_ﬂ::t (¥
[ e IRV

RTE
2 Click the RTE filter icon | =¥ .

3 Clear the IRV option.

"F |||
Select All
Unselect All

QBAI
DV
MIVL
5-0OVFL
0P
COR

F‘.‘u"

HF

A==

The software hides the IRV check for Square_Root ().

é--Squs’E_H::t (1
fol v
f sTo_LBS
~F NIvLZ

4 Select the IRV option to redisplay the IRV check.
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Note When you filter a check category, red checks of that category are not
hidden. For example, if you filter IDP checks, you still see IDP.9 under
Pointer_Arithmetic().

Example: Filtering Green Checks

You can use a Color filter to hide certain color checks. When a filter is
enabled, you do not see that color check.

To filter green checks:

1 Expand Square_Root ().

Square_Root () has five checks: four are green and one is red.

L
2 Click the Color filter icon | =¥ .

3 Clear the Green Checks option.
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4-24

“" Run-Time Checks

RTE
-

%W

Proce

E'..

[ s OO OO OO s O 'ﬁz &

[<]<]

H

Select All
Unselect All

. Gray Checks
. Orange Checks

[<]<]

Green Checks

e

. Checks in nen executable procedures
. Orange checks possibly impacted by inputs

The software hides the green checks.

é--&quar&_ﬂcﬂt i)
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Reviewing Results Systematically

In this section...

“Reviewing Checks at Level 0” on page 4-25
“Reviewing Checks at Levels 1, 2, and 3” on page 4-26
“Reviewing Checks Progressively” on page 4-28

Reviewing Checks at Level O

At this level, in addition to red and gray checks, you can focus on orange
checks that Polyspace identifies as potential run-time errors. These potential
run-time errors fall into three categories:

® Path — The software identifies orange checks that are path-related issues,
which are not dependent on input values.

® Path and bounded input — In addition to orange checks that are
path-related issues, the software identifies orange checks that are related
to bounded input values.

e All — In addition to path-related and bounded input orange checks, the
software identifies orange checks that are related to unbounded input
values.

To specify the potential run-time error category for level 0:

1 In the Polyspace verification environment, select Options > Preferences.
The Polyspace Preferences dialog box opens.

2 Select the Review configuration tab.

3 From the Level drop-down list, select your category.

Ir'qh::u'ua -

Fath
Path and bounded input
All
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4-26

The default is None, that is, the software displays only red and gray checks.

4 Click OK to save your options and close the Polyspace Preferences dialog
box.

To select review level 0, in the Run-Time Checks toolbar, move the Review
Level slider to 0.

Reviewing Checks at Levels 1, 2, and 3

In addition to red, gray, and green checks, the software displays orange
checks according to values specified on the Review Configuration tab in the
Polyspace Preferences dialog box. See “Viewing Methodology Requirements
for Levels 1, 2, and 3” on page 4-27

You can use either a predefined methodology or a custom methodology to
specify the number of orange checks per check category.

To select a predefined methodology and review level:

1 From the Run-Time Checks perspective, select Options > Preferences.
The Polyspace Preferences dialog box opens.

2 Select the Review configuration tab.

3 From the Methodology drop-down list, select, for example, Methodology
for C.

IMethudolugy for C -

Methodology for C
Methodology for C++

Methodology for Model-Based Design

4 Move the Review Level slider to the appropriate level, for example, level 1.

a 1 z 3 Al
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Viewing Methodology Requirements for Levels 1, 2, and 3

In this part of the tutorial, you examine Methodology for C, which defines
the number of orange checks that you review at levels 1, 2, or 3.

To examine the configuration for Methodology for C:

1 In the Polyspace verification environment, select Options > Preferences.
The Polyspace Preferences dialog box opens.

2 Select the Review configuration tab.

3 From the Methodology drop-down list, select Methodology for C.

In the section Levels 1, 2, and 3, a table shows the number of orange
checks that you review for a given level and check category.

Levels 1, 2, and 3

Level 1 Level 2 Level 3
Common
2oV 5 2 ALL
MNIVL 10 50 ALL
S-OVFL 10 50 ALL
COR 10 10
NIV 1] 10
F-OVFL 5 10 20
ASRT 5 20
C & C++only
OBAI 10 20 ALL
SHF 3 10 ALL
IDP 10 20
NIP 10 20
STD_LIB
C only

IRV

w
[¥]

ALL

For example, the table specifies that you review five orange ZDV checks
when you select level 1. The number of checks increases as you move from
level 1 to level 3, reflecting the changing review requirements as you move
through the development process.

4 Click OK to close the dialog box.
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Reviewing Checks Progressively

[
On the Run-Time Checks perspective toolbar, use the forward arrow to

move to the next unjustified check. The software takes you through checks
in the following order:

e All red checks
e All gray checks (the first check in each unreachable function).

® Orange checks — the number of orange checks is determined by the
methodology and review level that you select

Earlier in this tutorial, you selected Methodology for C, criterion 1. In this part
of the tutorial, you review the checks for example.c using this methodology

and criterion. To navigate through these checks:

1 Select the Assistant Checks tab.
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AssIsTant Checks
L

Check
i [single_file_analysis.c.reset_temperature. OBAL 2
o

example.c.Pointer_Arithmetic. IDP.9

single_file_analysis.c.generic_validation. MTC. 54

main. c.main. NTC. 3

example.c.Recursion_caller NTC. 1

example.c.RTE.NTC.2

main. c.interpolation.NTL.9

example.c.5guare_Root.5TD_LIB.5

initizlisations. c.compute_new_coordonates. UMR..5

single_file_analysis.c.generic_validation. UNR. 55

single_file_analysis.c.generic_validation. UNR. 56

example.c. Pointer_Arithmetic, UMR. 23

example.c.Unreachable_Code . UMR. 11

XM (K| 2 % %

main. c.interpolation. UNR. 13

single_file_analysis.c.generic_validation. OBAL. 45

example.c.Recursion.ZDV. 10

example.c.get_oil_pressure. NIVL.O

initizlisations. c.compute_new_coordonates, NIVL. 4

single_file_analysis.c.all_values_uis.NIVL.O

single_file_analysis.c.all_values_s32.NIVL.0

single_file_analysis.c.all_values_s16.NIVL.0

miain, c.main,NIVL. 4

miair, c.main.MIVL. 5

single_file_analysis.c.generic_validation. OVFL.43

example.c.Unreachable_Code OVFL. 4

example.c.Close_To_Zero.OVFL.4

3
b o i e e e e e e s o o e o

example.c.Close_To_Zero.OVFL.8

example.c.Close_To_Zero,OVFL.12

Click the forward arrow

The Source pane displays the source code for this check and the Check
Review pane displays information about this check.

to move to the next unjustified check.

Note You can display the calling sequence and track review progress, as
described in “Reviewing Results” on page 4-9.

Continue to click the forward arrow until you have gone through all of

the checks.

After the last check, a dialog box opens asking if you want to start again

from the first check.
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4-30

Wrapping search

End of the set of checks under review.

Yes |[ No ]

==

Do you want to start again from the first check?

4 Click No.




Automatically Testing Unproven Code

Automatically Testing Unproven Code

Reviewing orange code to find true errors is a time-consuming task. You can
use the Automatic Orange Tester to automatically create and run test cases

to identify errors in the orange code. The workflow for using the Automatic
Orange Tester is:

1 Set an option to indicate that you want the software to run the Automatic
Orange Tester at the end of the verification.

2 Run the verification. The software uses results from the Automatic Orange
Tester to identify potential run-time errors.

3 If you want perform further dynamic tests on the code, run the Automatic
Orange Tester manually.

4 Review the results.

To learn how to use the Automatic Orange Tester, see “Automatically Testing
Orange Code” in the Polyspace Products for C/C++ User’s Guide.
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Generating Reports of Verification Results

In this section...

“Polyspace Report Generator Overview” on page 4-32

“Generating Report for example.c” on page 4-33

Polyspace Report Generator Overview

The Polyspace Report Generator allows you to generate reports about your
verification results, using predefined report templates.

The Polyspace Report Generator provides the following report templates:

¢ Coding Rules Report — Provides information about compliance with
MISRA C Coding Rules, as well as Polyspace configuration settings for
the verification.

¢ Developer Report — Provides information useful to developers, including
summary results, detailed lists of red, orange, and gray checks, and
Polyspace configuration settings for the verification. Detailed results are
sorted by type of check (Proven Run-Time Violations, Proven Unreachable
Code Branches, Unreachable Functions, and Unproven Run-Time Checks).

* Developer Review Report — Provides the same information as the
Developer Report, but reviewed results are sorted by review classification
(High, Medium, Low, Not a defect) and status, and untagged checks are
sorted by file location.

* Developer with Green Checks Report — Provides the same content as
the Developer Report, but also includes a detailed list of green checks.

¢ Quality Report — Provides information useful to quality engineers,
including summary results, statistics about the code, graphs showing
distributions of checks per file, and Polyspace configuration settings for
the verification.

¢ Software Quality Objectives Report — Provides comprehensive
information on software quality objectives (SQO), including code metrics,
code analysis (coding-rules checker results), code verification (run-time
checks), and the configuration settings for the verification. The code




Generating Reports of Verification Results

metrics section provides is the same information displayed in the Polyspace
Metrics web interface.

The Polyspace Report Generator allows you to generate verification reports in
the following formats:

e HTML

e PDF

e RTF

® Microsoft Word
e XML

Note Microsoft Word format is not available on UNIX platforms. If you select
Word format on a UNIX platform, the software uses RTF format instead.

Generating Report for example.c

You can generate reports for any verification results using the Polyspace
Report Generator.

To generate a verification report:

1 If your verification results are not already open, open them.
2 Select Run > Run Report > Run Report.

The Run Report dialog box opens.
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( Run Report @

Select Report Template

C:\PolySpace \PolySpace _CommonReportGenerator templates\CodingRules. rpt

C:\PolySpace\PolySpace_Common'\ReportGenerator \templates\Developer.rpt
C:\PalySpace\PolySpace_Common \ReportGenerator templates \DeveloperReview.rpt
Ci\PolySpace\PolySpace_CommonReportGenerator \templates\Developer _WithGreenChecks.rpt
C:\PolySpace\PolySpace_CommonReportGenerator templatesQuality. rpt
Ci\PolySpace\PolySpace_Common'\ReportGenerator \templates\SoftwareQualityObjectives.rpt

Browse...

Select Report Format
Output folder | C:\PolySpace\polyspace_project\Werification_1\R.esult_2\Palyspace-Doc m
Output format | RTF -

Run Report l [ Cancel ]

3 In the Select Report Template section, select Developer.rpt.

4 In the Output folder section, select the \polyspace project folder.
5 Select PDF Output format.

6 Click Run Report.

The software creates the specified report. When report generation is
complete, the report opens.
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e “Setting Up Coding Rules Checking” on page 5-4
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About Checking Compliance with Coding Rules Tutorial

In this section...

“Overview” on page 5-2

“Before You Start” on page 5-3

Overview

Polyspace software allows you to analyze code to demonstrate compliance with
established C or C++ coding standards (MISRA C 2004, MISRA C++:2008,
or JSF++:2005).2

Applying coding rules can both reduce the number of orange checks in your
verification results, and improve the quality of your code. Coding rules are
the most efficient way to reduce orange checks.

To check compliance with coding rules, you set an option in your project and
then run a verification. Polyspace software finds the violations during the
compile phase of a verification. When you have addressed all coding rule
violations, you run the verification again.

For more information on the coding rules checker, see “Checking Coding
Rules”in the Polyspace Products for C/C++ User’s Guide

In this tutorial, you learn how to:

1 Create a second verification within your project.
2 Set an option for checking MISRA C compliance.
3 Select MISRA C rules to check.

4 Run a verification with MISRA C checking.

5 View coding rules violations using the Coding Rules perspective.

2. MISRA and MISRA C are registered trademarks of MISRA Ltd., held on behalf of the

MISRA Consortium.
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Before You Start

For this tutorial, you check the MISRA C compliance of the file example.c,
using the project that you created in Chapter 2, “Setting Up a Polyspace
Project”.
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5-4

Setting Up Coding Rules Checking

In this section...

“Opening Your Example Project” on page 5-4

“Creating New Module” on page 5-5

“Setting MISRA C Checking Option” on page 5-8

“Creating a MISRA C Rules File” on page 5-9

“Excluding Files from the MISRA C Checking” on page 5-12
“Configuring Text and XML Editors” on page 5-13

“Saving the Project” on page 5-14

Opening Your Example Project

For this tutorial, you modify the project in example.cfg to include MISRA C
checking. You use the Project Manager perspective to modify the project.

To open example project.cfg:
1 Select File > Open Project.
The Open a Polyspace project file dialog box opens.
2 Navigate to polyspace_project.
3 Select example project.cfg.

4 Click Open to open the file and close the dialog box.
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Creating New Module

A Polyspace project can contain multiple modules. Each of these modules can

verify a specific set of source files using a specific set of analysis options. In
this section, you create a second module to check coding rules compliance

for the example.c file.

To create a new module in example project:

1 In the Project Browser, select example_project [C].

2 Click the Create a new module icon

=

in the Project Browser toolbar.

A new verification, Module (2), appears in the Project Browser.

ALD|EAR S|+ ¥|3

Elg_',l example_project [C]
-3 Source
--EI Include
(3 Module_1
EJ 13 Source
=t 5 sources
i b | example.c
EJ l'j' Configuration
b E example_project
- lf' Result
: H-IES Result_1
E}E' Result_2 [Verification Completed]

E opticns

...... & Source

EI lﬂ Configuration
R E example_project

------ & Result

------ -] RTE_px_example_project_LAST_RESULTS.rte

3 In the Project Browser Source tree, right-click example.c, and select Copy

Source File to > Module_(2).
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The example.c file appears in the Source tree of Module (2).

R IEIEIE

Elr_ij example_project [C]
L'—J@ Source
E\E sources
=] =ample.c
E- Include
E—J"@ Module_1
EIE' Source
| EHEF sources
H e || example.c
EI E‘ Cenfiguration
= [ example_project
B E‘ Result
"a Result_1
E}E' F{esult_l [Verification Completed]
4 opticns
------ RTE_px_example_project_ LAST_RESULTS.rte
=+ Module 2
-3 Source
E}E sources

i b . example.c
El B Configuration
H @ example_project

------ & Result

4 Right-click the Configuration folder in Module (2), and select Create
New Configuration.

5 Right-click the example project 1 configuration, and select Set as
Active Configuration.

The Project Browser now looks like the following figure.
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“" Project Browser

T RIEEEE

El‘Eﬁ example_project [C]
E}@ Source

E'ﬁ SOUrCes
----- | | example.c

-1 Include

I:-}-@ Module_1

E| B Source

= ﬁ sources

E| B Cenfiguration
- [T example_project
El 177 Result
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Setting MISRA C Checking Option

You set up MISRA C checking by setting an analysis option and then selecting
the rules to check. To set the MISRA C checking option:

1 Select the example_project_(1) Configuration in the Project Browser.

2 In the Analysis options part of the Configuration pane, expand the

Compliance with standards option.

3 Select the Check MISRA C rules check box.

4 Expand the Check MISRA C rules option.

Three options, MISRA C rules configuration, Files and folders to

ignore and Effective boolean types, appear..

=I-Check MISRA C rules
--MISRA C rules configuration all-rules E] misra2
--Files and folders to ignore E] dncludes-to-gnare
-Effective boolean types E] -boolean-types

These options allow you to specify:
¢ Which MISRA C rules to check

¢ Files, if any, to exclude from the checking

® Data types that you want Polyspace to consider as Boolean

5 In the MISRA C rules configuration drop-down list, select custom.
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Creating a MISRA C Rules File

You must have a rules file to run a verification with MISRA C checking. You
can use an existing file or create a new one. You create a new rules file for
this tutorial by:

® “Opening a New Rules File” on page 5-9
e “Setting All the Rules to Off” on page 5-10
e “Selecting the Rules to Check” on page 5-10

Opening a New Rules File
To open a new rules file:

1 Click the button to the right of the Rules configuration option.
A window for opening or creating a MISRA C rules file opens.
2 Select File > New File.

A table of rules appears. For each rule, specify one of the following states.

State Causes the verification to...

Error End after the compile phase when
this rule is violated.

Warning Display warning message and
continue verification when this rule
1s violated.

Off Skip checking of this rule.

Note The default state for most rules is Warning. The state for rules that
have not yet been implemented is Off. Some rules always have a state of
Error (you cannot change this state).
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Setting All the Rules to Off
In this tutorial, you check only a few rules. Therefore, first set the state of all
rules to Off. Later, you can select the specific rules that you want to check.

To set the state of all rules to Off:
1 From the Set the following state to all MISRA rules menu, select Off .
2 Click Go.

Selecting the Rules to Check
To select the rules to check for this tutorial:

1 Expand the set of rules named 16 Functions.

2 Select the Error column for 16.3.

3 Expand the set of rules named 17 Pointers and Arrays.
4 Select the Warning column for 17.4.

The completed rules table looks like the following figure:
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— C\PolySpace\polyspace_project\misra E
File

o d

Set the following state to all MISRA C rules :

Rules Error Warning  Off
MISRA C rules -
-Number of rules by mode : 1 1 140 B

H--1 Environment

t-2 Language extensions
H--3 Documentation

H--4 Character sets

H--5 Identifiers

H-6 Types

H-7 Constants

H-9 Initialisation

t--10 Arithmetic type conversions

H--11 Pointer type conversions

H--12 Expressions

t-13 Control statement expressions

H--14 Control flow

[
[
[
[
[
[
[
[#-8 Dedarations and definitions
[
[
[
[
[
[
[

H--15 Switch statements

m

[=1-16 Functions

il

-16,1 Functions shall not be defined with variable numbers of arguments.

-16,2 Functions shall not call themselves, either directly or indirectly.

--16.3 Identifiers shall be given for all of the parameters in a function prototy

- 16,4 The identifiers used in the dedaration and definition of a function shall

- 16,5 Functions with no parameters shall be dedared with parameter type v

-16,6 The number of arguments passed to a function shall match the numbe:

16,7 A pointer parameter in a function prototype should be dedared as poi

--16,8 All exit paths from a function with non-void return type shall have an ¢

--16,9 A function identifier shall only be used with either a preceding &, or wi @]

(] (@l ( ||:|| 1@l E]
|| (CHCHCTHSICHC

--16, 10 If a function returns error information, then that error information sh @

=17 Pointer and arrays

--17. 1 Pointer arithmetic shall only be applied to pointers that address an arr

--17., 2 Pointer subtraction shall only be applied to pointers that address elem

17,3 =, ==, <, <= shall not be applied to pointer types except where they

--17.4 Array indexing shall be the only allowed form of pointer arithmetic.

17,5 The dedaration of objects should contain no more than 2 levels of poir| ® @
17,6 The address of an object with automatic storage shall not be assigned ® @
[+-18 Structures and unions -
4 m | b
| ok || conel
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5 Click OK to save the rules and close the window.
The Save as dialog box opens.

6 In File, enter misrac.txt

7 Click OK to save the file and close the dialog box.

Excluding Files from the MISRA C Checking

You can exclude files from MISRA C checking. You might want to exclude
some included files. To exclude math.h from the MISRA C checking of the

project example.cfg:

1 Click the button to the right of the Files and folders to ignore
option.

The Files and folders to ignore dialog box opens.

E ==

Files and folders to ignore [Hncdudes-to-ignore]

C:'\PolySpace\polyspace_projectiindudes

oK || cancel |

2 Click the folder iconi‘.
3 Navigate to the folder polyspace_project\includes.
4 Select the file math.h.

5 Click OK.
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The file math.h appears in the list of files to ignore.

6 Click OK to close the dialog box.

Configuring Text and XML Editors

Before you check MISRA rules, configure your text and XML editors in the
Preferences. Configuring text and XML editors allows you to view source files
and MISRA reports directly from the Coding Rules perspective.

To configure your text and . XML editors:

1 Select Options > Preferences.
The Preferences dialog box opens.

2 Select the Editors tab.

= Puolyspace Preferences @
Tools Menu | Review statuses | Assistant configuration I Miscellaneous | Character encoding -
Server configuration | Results folder | Editors | Generic targets

¥ML editor configuration

m

Specify the full path to & XML editor or use the browse button,

0]

¥ML Editor: C:\Program Files (x86) WMicrosoft Office\Office 12\EXCEL.EXE

Text editor configuration

Specify the full path to a text editor or use the browse button.

D)

Text Editor: C:\Program Files\Windows NT\Accessorieswordpad exe
Specify the command line arguments for the text editor,
Arguments: Wordpad  « | |SFILE

T 3

| OK || Apply || Cancel

3 Specify an XML editor to use to view MISRA-C reports. For example:

C:\Program Files\MSOffice\Office12\EXCEL.EXE
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4 Specify a Text editor to use to view source files from the Project Manager
logs. For example:

C:\Program Files\Windows NT\Accessories\wordpad.exe
5 Select your text editor in the Arguments drop-down menu to automatically
specify the command line arguments for that editor.
® Emacs
® Notepad++
e UltraEdit
® VisualStudio

®* Wordpad

If you are using another text editor, select Custom from the drop-down
menu, and specify the command line arguments for the text editor.

6 Click OK.

Saving the Project
Save your project to save your new verification and analysis settings.

5-14



Running a Verification with Coding Rules Checking

Running a Verification with Coding Rules Checking

In this section...

“Starting the Verification” on page 5-15
“Examining MISRA C Violations” on page 5-17
“Opening MISRA-C Report” on page 5-21

Starting the Verification

When you run a verification with the MISRA C option selected, the verification
checks most of the MISRA C rules during the compile phase.?

If there is a violation of a rule with state Error, the verification stops.
To start the verification:
1 Select Verification_(2) in the Project Browser.

¥ Run

2 Click the Run button on the Project Manager toolbar.

The verification fails because of MISRA C violations. The message
“Verification Failed” appears at the bottom of the Project Manager
perspective, and the Output Summary indicates that the verification has
detected MISRA errors.

3. MISRA and MISRA C are registered trademarks of MISRA Ltd., held on behalf of the
MISRA Consortium.
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5-16

% Output Summary - [C:\PolySpace\polyspace_project\Werification_2\Result_3]

Search: +

has detected MISEA error(s) in the code.

Class Description File Line Caol
i example_project for C verification start at Dec 15, 2010 18:33:40
a
] Exiting because of previous error
Detail:
Error:
Verifier
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Examining MISRA C Violations
To examine the MISRA C violations:

1 Double-click MISRA-C-report.xml in the Project Browser Result folder.

The Coding Rules perspective appears, displaying a list of MISRA C
violations.

File Edit Run Review Options Window Help

EEFIEEEECEEY D] | Goanras)
# Assistant Coding Rules & 2 | MISRA C
4+ + Filter | | Hide justified violated rules i
! ) =
Rulle Fie  line  Cal | wie Rule  File Line | Col Classification  Status Justified Comment
lerror 16.3  |[indude.h 33 28 &
warning [17.4  |example.c a7 7 &
warning |17.4  |example.c 114 21 &
warning |17.4  |example.c 118 14 &

“" Rule details

0% | Ready

2 Click any of the violations to see a description of the violated rule, the
full path of the file in which the violation was found, and the source code
containing the violation.
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File Edit Run Review Options Window Help

‘Eﬂ“|q(‘|¥%@|% 0ﬂ|@3'| |~?~QodngRLﬂES'
® Assistant Coding Rules @ 23 | < MISRAC
4t Filter |:| Hide justified violated rules i
) =

Rulle File Line  Cal | wfe Rule File Line Col Classification Status Justified  Comment

: indude.h ]

fwarning  [17.4  |example.c a7 7

warning  (17.4  |example.c 114 21

warning  (17.4  |example.c 118 14

=" Rule details

Bule: 16.3 (error): Identifiers shall be giwen for all of the parameters in a function prototype declaration.
File: C:\Poly3pace‘\polyspace_projectiincludes‘\include.h line 33 (column 28)

Source code
|extern void Exec One Cvcle (int):

~

b 0% || Ready

The log reports a violation of rule 16.3. A function prototype declaration in
include.h is missing an identifier.

3 Right-click the row containing the violation of rule 16.3, and select Open
Source File.

warning  |17.4 | *= Open SourceFile
warning 17.4
warning 17.4

Add Pre-Justification to Clipboard
Open MISRA-C Report
% Configure Editor

The include.h file opens in your text editor.
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Note Before you can open source files, you must configure a text editor.
See “Configuring Text and XML Editors” on page 5-13.
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5-20

Eu [ & = |include.h - WordPad

Home View
D Courier New 11 v A A

Paste B 7 U ae X |x|L- A S
Clipboard Font Paragraph

=]

#ifndef INCLUDE H
fdefine INCLUDE H

fdefine true 1
fdefine false 0O

fdefine checksum 1
#define new move 0
fdefine previous move 1

$define MAX SIZE 10

/* autcomatically stubbed functions */

extern int read bus status (void);
extern int error on bus(void);
extern int read on bus(void);

/* internal functions */

void initialise current_data(void);
void compute new coordonates (void);
void sort calibration(wveoid);

int polynomia (int input);

int random_int (veoid);

float random float(void);

extern void partial init(int *new_alt);
extern void RTE(wvoid);

extern void Exec One Cycle (int);

B R T B T B R B SR AR B SR

BN (B =X

=l ||| a8

Insert | Editing

€| 1

extern wvoid SEND_MESSAGE{int status, const char “*message);

7]

m

100% (=) -

J

4 Correct the MISRA violation and run the verification again.
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The verification then is completed, and the results will be the same as
those from the tutorial in Chapter 3, “Running a Verification”.

Opening MISRA-C Report

After you check MISRA rules, you can generate an XML report containing all
the errors and warnings reported by the MISRA-C checker.

Note Before you can open a MISRA-C report, you must configure an XML
editor. See “Configuring Text and XML Editors” on page 5-13.

To view the MISRA-C report:

1 Click the Coding Rules button in the Polyspace Verification Environment

toolbar.

A list of MISRA C violations appears in the Coding Rules perspective.

2 Right-click any row in the log, and select Open MISRA-C Report.

Warning
warning 17.4
warning 17.4

%= Open Source File

Add Pre-Justification to Clipboard

Open MISRA-C Report
% Configure Editor

The report opens in your XML editor.
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Cin \d9-© ' = Book2 - Microsoft Excel Table Tools =aERt
S ) ) i
‘ Home l Insert Page Layout Formulas Data Review View Add-Ins Acrobat Design @ - =7 X
E * Calibri E‘Wrap Text General = ﬁ @ Bt - ﬂ [ﬁ
B I Delete - -
Paste =i Merge & Center Conditional Format — Cell || . sort & Find &
7 EZ 2 Formatting ~ as Table ~ Styles - @Formatv A7 Filter~ Select—
Clipboard ™= Alignment Mumber Styles Cells Editing
Nameld Modeﬂ
16.3 required error C: \PoIvSpaoe\polyspaoeJ)rOJect\mcludes\lnclude h 33 0| Identlflers shall be given for all of the parameters in a function protc
17.4 required warning example.c 97 0 | Array indexing shall be the only allowed form of pointer arithmetic.
17.4 required warning example.c 114 0 | Array indexing shall be the only allowed form of pointer arithmetic.
17.4 required warning example.c 118 0 | Array indexing shall be the only allowed form of pointer arithmetic.
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